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Overview 
The analysis of slopes is one of most important problems in engineering geology. There are 

numerous methods developed for solving it within the frames of the limit equilibrium theory [1]. 
Those methods are based, as a rule, on the following assumptions. 

The mechanism of the stability loss is assumed to be a slip of a bulk of soil with respect to a 
stationary part of the slope. The boundary between the two bodies of soil is called a slip surface. 

The resistance to shear on the slip surface is calculated for static conditions. The criterion of 
soil disruption in the form of Coulomb’s law is used along the whole surface. 

The actual shear stress obtained by the calculation is compared with the ultimate shear 
resistance, and the result of the comparison is expressed as a stability number (coefficient), K. For a 
particular slip surface, the K coefficient is a number such that if the strength characteristics (the 
internal friction angle and the specific cohesion) along the whole surface are made K times smaller,  
then the disrupted bulk of soil as a whole will be in the ultimate equilibrium state. The stability 
coefficient of a slope is a minimum stability coefficient for all potential slip surfaces  which satisfy 
given limitations (the limitations are usually defined by the method of analysis). 

The real slip surface is three-dimensional. However, most methods of analysis including the 
SLOPE software assume a plane strain hypothesis where the slip surface is cylindric with is 
generatrices parallel to the slope’s surface and the problem is how to find a critical generatrix called 
a slip line. This approach is based on the hypothesis that ignoring the spatial character of the 
phenomenon  affects the stability coefficient too little and, by the way, creates an additional reserve 
of strength. 

Various, usually fairly narrow, classes of potential slip lines are used (such as circular arcs or 
logarithmic spirals). However, it is obvious that the limitations of the slip surface configuration 
must be minimal for essentially inhomogeneous slopes and complicated groundwater conditions 
which this software takes into consideration. 

The algorithm of analysis implemented in the SLOPE software is based on a procedure 
suggested in [2],[3] which is based on the method of variable level of shear-strength mobilization 
(MVLM). 
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Controlling the software 
Operations are controlled, data are prepared, and results of analyses are documented in the 

SLOPE software much in the same way as in other design and analysis applications included in the 
SCAD Office® package. 

The application uses a standard mutli-tab dialog box (Fig. 1), just like the other applications of 
the package. To activate a page of it, click its respective tab at the top; also, the menus can be used. 

You prepare source data on four tabs: General, Soil, Boreholes and Loads. Source data for a 
geologic section of the slope are checked for validity and the results of analysis (the slip surface) 
are displayed on the Section tab. 

 
Fig. 1. The dialog box of the Slope software, 

the General data tab 

Menus 
The menus are used to customize the application and to invoke various service functions. 

There are four pull-down menus: File, Settings, Tools, Help. 
The File menu includes the following menu items: 
New — invokes a new analysis. This fills all edit fields in all tabs of the application with 

zeros, and a message box appears suggesting the user to save her previous data if those have not 
been saved yet. 

Open — opens a file of source data. 
Save  — saves the source data as a file. 
Save As... — saves the source data under a different filename. 
Exit — finishes the current session of the application. 
The Settings menu is used to invoke the Application Settings dialog box where settings 

needed for the application to operate are set up and customized. 
The Tools menu helps run the standard Windows calculator, a formula calculator, and a 

measurement unit conversion program. 
The Help menu offers items for invoking reference help information on how to control the 

SLOPE application, how to use the Windows help system, and information about the application 
(No. of its version and the last modification date). 

The operations accessible through Help and Tools are described in the Appendix. 
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Settings 
The Application Settings dialog box (Fig. 2) is opened via the Settings menu and contains 

three tabs: Units of Measurement, Report and Languages, Display. 

 
Fig. 2. The Units of Measurement tab of the Application Settings dialog box 

The Units of Measurement tab is used to specify units for the source data and the analysis 
results. The units of measurement can be changed at any moment of working with the application. 
Drop-down lists are used to assign elementary units such as linear sizes or forces. If the units are 
compound, the drop-down lists display the current units, and the Set Up Units of Measurement 

dialog boxes (Fig. 3) are used to assign the new ones. The dialogs are invoked by clicking the  
button on the right of the drop-down list. To specify units of measurements, choose the desired ones 
in the list and click OK to exit the dialog and confirm your choice. 

The Report and Languages tab (Fig. 4) is used to specify a language for the user interface, a 
form of representation of the report, a format of the report document etc. It includes the following 
controls: 

 View/Edit — invokes a report viewing/editing application associated with the RTF file 
format; 

 Print — prints the report without displaying it on the monitor; 

 Report Type — a drop-down list suggests you to choose a file format for the report 
document. An RTF file can be generated in either of two formats: Word 7 (Word Pad) or Word 97 
and newer; a DOC file, an HTML file, or a PDF file can be created, too. To view/print the report in 
the PDF format, you need to have an application like Adobe Acrobat Reader installed (this 
application is freeware and can be downloaded at http://www.adobe.com); 

the Paper, Indents, and Orientation groups are used to customize the report’s format; 
the Headers/Footers field asks for a reference to an RTF file where the page headers and 

footers for the report are contained. This file can be prepared by the user. 
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Fig. 3. The Set Up Units of 
Measurement dialog box 

Fig. 4. The Report and Languages tab of the 
Application Settings dialog box 

The Display tab is used to set up a font for text messages and a line color for displaying the 
groundwater level on the screen and in the report. Left-double-clicking the line with the current font 
depicted will open the standard Windows dialog, Font, in which to make the desired settings. 

Working with tables 
Most source data for the analysis are specified in a tabular form (Fig. 5). General rules for 

entering data in the tables follow: 
• the data are entered as decimal numbers; the separator between the integral and fractional part 

of a number (comma or period) depends on the Windows user settings; 
• in cases when the number of rows in a table is defined by the user, the table has two buttons, 

Add and Delete, near it; the former is used to add a new row after the currently selected one 
and the latter deletes one or more selected rows; 

• to select one or more adjacent rows, put the mouse pointer on the identification number of the 
first of those, click and hold the left mouse button, move the pointer over the numbers of rows 
to be selected, and then release the button; 

• to switch between the table’s cells, use the Tab key on your keyboard. 

 
Fig. 5. An example of a table with soil properties 
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As the new rows are added after a selected one, you will need to do the following if you 
want to add a row before the first row of the table: 

 select first row in the table and click the Add button to add a new row after it; 
 select first row in the table and press the keys Ctrl+Insert simultaneously; this will copy the 

contents of the first row to Windows Clipboard; 
 select second (new) row in the table and press the keys Shift+Insert simultaneously; this 

will write the contents of the Clipboard to the cells of the second row, and now the first row 
can be filled with data as desired. 

The actions listed above can be also used to copy one or more selected rows of the table. 

Preparing source data 

The General tab 
The analysis of stability of a slope and the search for a most probable slip surface are based on 

known intervals of the beginning and the end of the landslip. This tab is used to specify the sizes of 
a landslip-risky piece of the slope. These include four numbers in general: r1, r2, which determine 
the interval in which the admissible abscissas of the landslip’s beginning may vary, and r3, r4, 
similar data for the end of the landslip. As the slope may be directed either left to right or vice 
versa, the ‘beginning’ and the ‘end’ of the landslip are conditional notions which may swap over 
when the slope goes from right to left (Fig. 6). Independently of the slope’s direction, the following 
rules must be observed when specifying the values for r:  r4 > r1, r2 ≥ r1, r4 ≥ r3. The direction of the 
slope is defined by the characteristics of the boreholes (specified on the Boreholes tab). 

 
Fig. 6.  

In addition to the sizes of the landslip-risky area, the General tab (Fig. 1) is used to specify 
options of the analysis which include: 

Admissible error for х, the accuracy at which to determine the marks of the slip surface; 
Presence of tension break, the checkbox that indicates whether there is or not a cutter break 

at the beginning of the landslip. If this checkbox is enabled, then you should enable also the 
checkbox that indicates where the boundary of the landslip’s beginning is (Tension crack on the 
left for the slope left to right, Tension crack on the right for the slope right to left). The depth of 
the cutter break is specified in the Size of tension crack edit field. 

It should be noted that the tension crack must be located at the beginning of the landslip (at a 
higher point of the slip line). The application does not verify the specified location of the crack (the 
tension crack on the left/right alternative). 

Automatic tension crack calculation, the checkbox that indicates that during analysis the 
possibility of creation or propagation (when checkbox Presence of tension break is turned on) of 
tension crack must be taken into analysis.  

The Soils tab 
This tab (Fig. 7) is used to specify soil characteristics. The order in which the soils are 

defined is of no importance. The following soil data are required for the analysis (the parentheses 
contain default units of measurement): 

• angle of internal friction (degrees);  
• specific cohesion (tons per square meter); 
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• specific weight of dry soil (tons per cubic meter); 
• specific weight of soil when saturated with water (tons per cubic meter). 

Also, the respective item should be chosen from the list in the Type column for waterproof 
soil. Every soil type can be associated with its particular color; this makes it easier to monitor the 
structure of the soil body on the Section tab. 

The number of groundwater tables (0 to 3) is specified by choosing an appropriate number 
from the list under the respective name. Each water level is specified on the Boreholes tab.  

 
Fig. 7. The Soil tab 

The Boreholes tab 
The geologic section of a slope is defined by specifying a set of boreholes on the tab under 

the respective name (Fig. 8). It is the top boundary marks of the uppermost soil layers which define 
the direction and the ratio of the slope. The marks can be specified in any coordinate system, 
provided it is the same for all boreholes. 

To specify the characteristics of the boreholes, follow these steps:  
 click the Add borehole button (the No. of borehole list will display its current 

identification number);  
 in the Soils table, choose a row with the name of the top soil layer of the current 

borehole and click the button  to carry it over to the Layers table;  
 repeat the above action for each soil of the current borehole in their order from the 

surface down;  
 specify top boundary marks for the levels of all soils; 
 if the number of groundwater tables is not zero, specify a level mark (in meters) for each 

table in the Groundwater Levels table; 
 specify a horizontal coordinate for the borehole with respect to the coordinate origin of 

the landslip-risky slope (the horizontal coordinates of the boreholes may not coincide);  
 specify a name for the borehole (this name will be displayed on the slope’s section and 

in the borehole description table of the Report); 
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 return to the first step and repeat all the steps described above for each of the following 
boreholes.    

 
Fig.8. The Boreholes tab 

The order in which the boreholes are described is of no importance because each borehole’s 
coordinate is bound to the X-axis separately. 

It should be noted that there is no way to restore the structure of a body of soil knowing only 
the structure of the boreholes in it. This fact is obvious in the following simple example. Suppose 
there are two boreholes of the following structure: 

Borehole 1 Borehole 2 
Soil Top boundary mark Soil Top boundary mark 

Loam 0 Sand 0 
Clay -10 Loam -10 

 
The geologic section can be something like this: 

 
 
 
 
 
 

or 

 
The ambiguity like this can be eliminated by specifying the same package of soil types for 

each borehole. That is, each borehole has the same package of soils in the same order (only their top 
boundary marks are different), and the lack of a soil (say, i-th) in a particular borehole is indicated 
by specifying the same level mark for both i-th and (i+1)-th soil. For the example above, the 
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structure of the boreholes should be described in this way (supposing the picture of the geologic 
section on the right is true). 

 
 

Borehole 1 Borehole 2 
Soil Top boundary mark Soil Top boundary mark 
Sand 0 Sand 0 
Loam 0 Loam -10 
Clay -10 Clay -10 

The Loads tab 

 
Fig. 9. The Load tab 

This tab (Fig. 9) is used to specify loads (diagrams) which act on a certain piece of the slope. 
The loads are approximated by piecewise linear functions of coordinate х, and the descriptions of 
those are bound to the boreholes for convenience. The application deals with distributed loads 
directed vertically and/or tangentially to the slope at the top point of the boreholes. The default 
values of the load on the left and on the right of each borehole are zero. Thus, if you need to specify 
a distributed load on a piece of the slope between two adjacent boreholes, you should indicate on 
what borehole it begins and where it ends. The specified loads are checked for validity in the Load 

Diagram dialog box invoked by the View Load Diagram button . 

For example, the trapezoid load between boreholes C2 (30 t/m) and С3 (40 t/m) specified in 
the table in Fig. 10 and displayed in the preview window, Load Diagram (Fig. 11), is defined by 
the user as follows: 

the Vertical On The Left column specifies zero for borehole С2; it means that there is no 
load to the left from borehole С2; 

the Vertical On The Right column specifies 30 t/m for borehole С2, i.e. there is load to the 
right from borehole С2, its initial value being 30 tons per meter; 

the Vertical On The Left column specifies 40 t/m for borehole С3, i.e. the final value of the 
load on the С2-С3 area will be 40 tons per meter; 
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the Vertical On The Right column specifies zero for borehole С3 which means there is no 
load to the right from borehole С3. 

In the same way, a uniformly distributed tangential load (12 tons per meter) is specified 
between the same boreholes. 

Fig. 10. The Section tab Fig.11. The Load Diagram dialog box 

When specifying loads, follow the sign convention presented in Fig. 12. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

Fig. 12. The 
sign convention 
for specifying 

loads applied to 
a slope 

 Fig. 13. The Section tab that displays a slip surface 
To calculate the stability coefficient taking into account the seismic action, choose from the 

list a seismic category of the site expressed in points, specify the acceleration in the soil during the 
seismic event (if its value is different from standard one) and the angle of application of the seismic 
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load. If the calculation without the seismic load is also required, it suffices to set one of the 
parameters to zero (such as the acceleration in the soil). 

The seismic load is taken into account under the assumption that the whole mass of soil 
moves synchronously at a user-specified acceleration, and the direction of the acceleration vector 
conforms to the given angle of application of the seismic load. Volumetric inertial forces appearing 
in this process are equal to the product of the specific weight by the acceleration and are included in 
the analysis. 

Performing the calculation and displaying its results 
To calculate the stability coefficient, click the Calculate button. The calculation consists of 

two phases: refinement of the initial approximation and then calculation of the stability coefficient 
and construction of the slip surface. The slip surface is displayed on the section of the slope, on the 
Section tab (Fig. 13). A report can be generated after the results of the calculation. 
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APPENDIX 

Formula calculator 

The formula calculator can be invoked from the SCAD Office program group via the  
icon. The Tools menu contains items for invoking additional calculators: a standard one of MS 
Windows (provided it has been installed) and a special calculator (Fig. 14) which lets you calculate 
formulas. 

This calculator is used to perform calculations by formulas that one can specify in a text edit 
field. 

The following rules should be observed when entering a formula: 
• names of functions must be entered in lowercase Roman letters; 
• the fractional and the integral parts of a number must be a period; 
• arithmetic operations must be specified with the symbols +, −, *, /, ^ (raising to a power), for 

example, 2.5*2.5*2.5 can be written as 2.5^3. 
The following mathematical functions can be used in the formulas: 

 
Fig. 14. The calculator’s dialog box 

floor — the greatest integer not greater than the 
argument; 
tan — tangent; 
sin — sine;  
cos  — cosine;  
asin — arc sine; 
acos — arc cosine; 
atan — arc tangent; 
exp — exponent; 
ceil — the least integer greater than the argument; 
tanh — hyperbolic tangent; 
sinh — hyperbolic sine; 
cosh — hyperbolic cosine; 
log — natural logarithm; 
log10 — decimal logarithm;  
abs — absolute value; 
sqrt — square root. 

Depending on the state of the Degrees/Radians switch buttons, arguments of the 
trigonometric functions (sin, cos, tan) and results of inverse trigonometric functions (asin, acos, 
atan) can be presented in degrees or radians, respectively. 

Only parentheses are allowed for grouping arguments together; these can be nested as deeply 
as desired. 

Example.  
The formula 

51, 2 sin(0,43) 6,7 6,8 0,003+ + −  
must be written as follows: 

1.2+sin(0.43)+6.7*sqrt(6.8)−0.003^(1/5). 

There is an additional option of using three independent variables x, y, z in formulas. Values 
for the variables are specified in respective edit fields. This makes it possible to perform a series of 
similar calculations with different parameters. For example, to use this mode with the following 
formula 

51, 2 sin( ) 6,7 6,8x y+ + −  

write it as 
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1.2+sin(x)+6.7*sqrt(6.8)−y^(1/5). 

Also, the calculator lets you enter a symbolic expression that depends on variables x, y, z and 

enable one of the marker buttons  ,  ,  to get a symbolic expression of the respective 
partial derivative. Just enter the formula, and the field at the bottom will display its partial 
derivative with respect to one of the variables (x, y, or z) for which the respective marker is enabled 
at the moment. 

Converter of measurement units 

This calculator can be invoked either via the SCAD Office program group using the  icon 
or via the Tools menu. This piece of software converts data between different systems of 
measurement units (Fig. 15). To do a desired action, choose a tab with the respective measures 
(Length, Area etc.). 

 
Fig. 15. The Convert units of 

measurement dialog box 

The operations needed to do the conversion depend on 
whether the units are elementary (such as length, mass, or 
time) or compound (such as pressure, speed, or area). 

To convert between elementary units of measurement, 
just enter a number in one of the text fields. The result will 
consist of the respective values in the other fields. If the 
unit is compound, choose a unit to convert from in the 
drop-down lists of one line and units to convert to in the 
lists of the second line. The text field of the first line 
accepts your number, and the text field of the second line 
displays the conversion results. 
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